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S1. Description of comparison constraints provided by the panel 

1. Sample type: This indicates if there were any instrumental or experimental setup conditions that 

are not reflective of general atmospheric conditions. Sample type is classified into ‘Ambient’ 

(immediate ingestion of ambient air to the instrument) and ‘Non-ambient’ (including all chamber 

studies, any measurement whereby the spectrum is a specific source or a standard, collected on 

filters as a preliminary step). 

2. Perturbation: This indicates if there was a perturbation of the sample due to some instrumental 

intermediary. If the sampling was carried out with an oxidation flow reactor, a thermodenuder, or 

if a sample was collected on filters, for example, it is classified as ‘Perturbed’, if not, ‘Non-

Perturbed’. 

3. Deconvoluted: This denotes if the spectrum was generated by an analysis step such as positive 

matrix factorization (PMF). If yes, then ‘Deconvoluted’, if not, then ‘Non-deconvoluted’ 

4. Instrument: This indicates the instrument used for detection. It includes Air Quality ACSM, 

ToF-ACSM, Quad-AMS, C-ToF-AMS, HR-ToF V-mode, HR-TOF W-mode, Long-ToF V-mode, 

Long-ToF W-mode, and multiple instruments. 

5. Resolution: This indicates the resolution of the sample spectrum. Options are UMR (unit mass 

resolution), HR to UMR (high resolution converted to UMR), and combination (HR for low 

masses, UMR for high).  

6. Vaporizer type: The two options are a capture vaporizer and a standard vaporizer. 

7. Aerosol CO and CO2 contributions: This indicates whether the signals of CO+ at m/z 28 and 

CO2+ at m/z 44 in the mass spectrum were adjusted to be equal during the data processing. In the 

case of UMR data, the default signal from aerosol CO+ at m/z 28 is set to be identical to the 

contribution from aerosol CO2
+ signal at m/z 44 (Allan et al., 2004). Especially in the case of high 

biomass burning sources, users may have adjusted the organic component at m/z 28 to be different 

from that at CO2 at m/z 44. In the UMR case (‘mz 28/mz 44 = 1 (for UMR)’ on the UMR 

comparison tab of the panel), this option screens for cases when these two signals are equal, which 

is reflective of more ambient measurements and the default fragmentation table, and for cases 

when these signals are not equal (‘Ratio ≠ 1 (for both)’ on the UMR comparison tab), which is 

very uncommon. In the case of HR data, the default setting is to not fit the CO+ ion, as it is generally 

unseparated from the dominant N2
+ ion at m/z 28. The default setting in the HR fragmentation table 

is to set the signal of aerosol CO+ to aerosol CO2
+.  In terms of HR families, this default setting 

means that the family CHO1 signal at m/z 28 is equal to the family CHOgt1 signal at m/z 44. In 

the HR case (‘CO (CHO1) / CO2 (CHOgt1) = 1 (for HRtoUMR)’ on the UMR comparison tab or 

‘CO/CO2 =1’ on the HR comparison tab of the panel), this option screens for cases when these 

two signals are equal, which is reflective of more ambient measurements and the default HR 

fragmentation table, and for cases when these signals are not equal (‘CO/CO2 ≠ 1’ on the HR 

comparison tab of the panel), which is very uncommon.  

 

https://www.zotero.org/google-docs/?p5ojlW
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Table S1. Description of the chemical formula for HR family name. 

HR family name Chemical formula 

Cx Cx 

CH CxHy 

CHO1 CxHyOz (z=1) 

CHOgt1 CxHyOz (z>1) 

CHN CxHyNw 

CHO1N CxHyOzNw (z=1) 

CHOgt1N CxHyOzNw (z>1) 

CS CxSy 

HO HxOy 

Air* Nx, Ox, Ar 

Cl HxCly 

NH NxHy 

SO SxOy 

NO NxOy 

Tungsten* WxOy (y≥0) 

Other All ions not included in any other category 

CSi CxSiy 

*On the HR comparison tab, air and tungsten abundances are reset to zero. 

 

Table S2. Top matches from HR “Ambient” sample comparison results with the BBOA factor from the 

DAURE campaign (m/z 1-200) depending on score and score with HR family (CH, CHO, and combined) 

Top 10 matches sorted by score with HR family (CH) 

# in 

DB 
Sample 

UMR 

Score 

Score with 

HR family 
Reference 

293 Changdao island_2011_biomass burning 0.9632 0.9589 (Hu et al., 2013) 

245 SOAR-1_Campaign_2005_SVOOA 0.9346 0.9565 (Docherty et al., 2011) 

246 MILAGRO Campaign_2006_BBOA 0.8119 0.9525 (Aiken et al., 2009) 

305 Beijing urban area_2010_MOOOA 0.7156 0.9433 (Hu et al., 2016) 

313 SOAS campaign_2013_LOOOA_II 0.9287 0.9376 (Hu et al., 2015) 

289 CalNex campaign_2010_CIOA 0.9036 0.9312 (Hayes et al., 2013) 

300 Beijing urban area_2011_HOA 0.9367 0.9309 (Hu et al., 2016) 

297 Changdao island_2011_HOA 0.8209 0.9309 (Hu et al., 2013) 

290 CalNex campaign_2010_LOA 0.8115 0.9306 (Hayes et al., 2013) 

292 CalNex campaign_2010_SVOOA 0.8352 0.9283 (Hayes et al., 2013) 

Top 10 matches sorted by score with HR family (CHO1) 

# in 

DB 
Sample 

UMR 

score 

Score with 

HR family 
 Reference 

310 SOAS campaign_2013_SOA 0.9445 0.9527 (Hu et al., 2015) 

270 Paris Summer_2009_MOA 0.904 0.9266 (Crippa et al., 2013) 

300 Beijing urban area_2011_HOA 0.9367 0.9153 (Hu et al., 2016) 

315 KORUS-AQ study_2016_LOOOA 0.9164 0.9098 (Hu et al., 2018b) 

255 DAURE campaign_2009_COA 0.8692 0.9093 (Mohr et al., 2012) 

278 DIAPASON2014 campaign_BBOA 0.9004 0.8979 (Struckmeier et al., 2016) 

269 Paris Summer_2009_SVOOA 0.9149 0.8919 (Crippa et al., 2013) 

https://www.zotero.org/google-docs/?VQ94dw
https://www.zotero.org/google-docs/?c4xs6D
https://www.zotero.org/google-docs/?dBjA2A
https://www.zotero.org/google-docs/?B68G6x
https://www.zotero.org/google-docs/?iUfUl2
https://www.zotero.org/google-docs/?wCSeJ9
https://www.zotero.org/google-docs/?ywoZw7
https://www.zotero.org/google-docs/?hYNasE
https://www.zotero.org/google-docs/?o8Jjlp
https://www.zotero.org/google-docs/?kdeoml
https://www.zotero.org/google-docs/?aQ3BEM
https://www.zotero.org/google-docs/?ki53TR
https://www.zotero.org/google-docs/?tmzlX6
https://www.zotero.org/google-docs/?WXrpG0
https://www.zotero.org/google-docs/?p5ehCp
https://www.zotero.org/google-docs/?Dkh3oD
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261 CARES campaign_2010_MOOOA 0.8644 0.8824 (Setyan et al., 2012) 

273 Xian and Beijing_BBOA 0.8963 0.8718 (Elser et al., 2016) 

277 Xian and Beijing_OOA 0.8521 0.8709 (Elser et al., 2016) 

Top 10 matches sorted by score with HR family (CHO1+CHOgt1) 

# in 

DB 
Sample 

Score 

(All) 

Score with 

HR family 
Reference 

310 SOAS campaign_2013_SOA 0.9445 0.9426 (Hu et al., 2015) 

278 DIAPASON2014 campaign_BBOA 0.9004 0.9378 (Struckmeier et al., 2016) 

293 Changdao island_2011_biomass burning 0.9632 0.9259 (Hu et al., 2013) 

270 Paris Summer_2009_MOA 0.904 0.9221 (Crippa et al., 2013) 

300 Beijing urban area_2011_HOA 0.9367 0.9114 (Hu et al., 2016) 

296 Changdao island_2011_CCOA 0.9239 0.9079 (Hu et al., 2013) 

255 DAURE campaign_2009_COA 0.8692 0.9038 (Mohr et al., 2012) 

277 Xian and Beijing_OOA 0.8521 0.9004 (Elser et al., 2016) 

261 CARES campaign_2010_MOOOA 0.8644 0.8957 (Setyan et al., 2012) 

313 SOAS campaign_2013_LOOOA_II 0.9287 0.8855 (Hu et al., 2015) 

Top 10 matches sorted by score with HR family (CH+CHO1+CHOgt1) 

# in 

DB 
Sample 

Score 

(All) 

Score with 

HR family 
Reference 

293 Changdao island_2011_biomass burning 0.9632 0.962 (Hu et al., 2013) 

310 SOAS campaign_2013_SOA 0.9445 0.9429 (Hu et al., 2015) 

300 Beijing urban area_2011_HOA 0.9367 0.936 (Hu et al., 2016) 

245 SOAR-1_Campaign_2005_SVOOA 0.9346 0.9322 (Docherty et al., 2011) 

313 SOAS campaign_2013_LOOOA_II 0.9287 0.9289 (Hu et al., 2015) 

296 Changdao island_2011_CCOA 0.9239 0.9256 (Hu et al., 2013) 

315 KORUS-AQ study_2016_LOOOA 0.9164 0.9225 (Hu et al., 2018b) 

243 SOAR-1_Campaign_2005_LOA 0.8121 0.9196 (Docherty et al., 2011) 

269 Paris Summer_2009_SVOOA 0.9149 0.914 (Crippa et al., 2013) 

301 Beijing urban area_2011_COA 0.9097 0.9061 (Hu et al., 2016) 

 

 

Table S3. Top matches from UMR “Ambient” sample comparison results with the OOA factor from the 

DAURE campaign (default setting, m/z 1-200) 

# in DB Sample Score Reference 

264 SPC Research Station Po Valley_2008_OOAc 0.9861 (Saarikoski et al., 2012) 

305 Beijing urban area_2010_MOOOA 0.9827 (Hu et al., 2016)  

262 SPC Research Station Po Valley_2008_OOAa 0.9801 (Saarikoski et al., 2012) 

263 SPC Research Station Po Valley_2008_OOAb 0.9801 (Saarikoski et al., 2012) 

244 SOAR-1_Campaign_2005_LVOOA 0.9779 (Docherty et al., 2011) 

311 SOAS campaign_2013_MOOOA 0.9778 (Hu et al., 2015) 

285 POPE2014 campaign_LVOOA 0.9776 (Struckmeier et al., 2016) 

299 Changdao island_2011_LVOOA 0.9760 (Hu et al., 2013) 

314 KORUS-AQ study_2016_MOOOA 0.9708 (Hu et al., 2018a) 

303 Beijing urban area_2011_MOOOA 0.9706 (Hu et al., 2016) 
 

 

https://www.zotero.org/google-docs/?vBKAGG
https://www.zotero.org/google-docs/?nX79lK
https://www.zotero.org/google-docs/?1r3Y2c
https://www.zotero.org/google-docs/?wGfLoc
https://www.zotero.org/google-docs/?bapLHl
https://www.zotero.org/google-docs/?eaRLRa
https://www.zotero.org/google-docs/?5UOkjA
https://www.zotero.org/google-docs/?Nn5l9e
https://www.zotero.org/google-docs/?PAhF5T
https://www.zotero.org/google-docs/?jyv3HH
https://www.zotero.org/google-docs/?JvbvbL
https://www.zotero.org/google-docs/?H5M5t0
https://www.zotero.org/google-docs/?zMhYiJ
https://www.zotero.org/google-docs/?b9Slsn
https://www.zotero.org/google-docs/?WzxNem
https://www.zotero.org/google-docs/?EmVaTR
https://www.zotero.org/google-docs/?NOcixK
https://www.zotero.org/google-docs/?s23mLD
https://www.zotero.org/google-docs/?1Xcou3
https://www.zotero.org/google-docs/?xusD3p
https://www.zotero.org/google-docs/?zMhYiJ
https://www.zotero.org/google-docs/?xusD3p
https://www.zotero.org/google-docs/?xusD3p
https://www.zotero.org/google-docs/?NOcixK
https://www.zotero.org/google-docs/?WzxNem
https://www.zotero.org/google-docs/?bapLHl
https://www.zotero.org/google-docs/?OQeZpr
https://www.zotero.org/google-docs/?dcC2vR
https://www.zotero.org/google-docs/?Pqwi7o
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Table S4. Top matches from UMR “Non-ambient” sample comparison results with the factors 1-6 from 

the DAURE campaign when setting new mass range (m/z 45-200). A blank space of the reference column 

serves as the equivalent of ditto-marks. 

Factor # in DB Sample Score Reference 

1 

334 Chamber m-Xylene aged SOA 0.9190 

(Loza et al., 2012) 212 Myrcene_O3 0.9172 

213 Terpinolene_O3 0.9165 

197 m-Xylene_O3 0.9155 

(Bahreini et al., 2005) 220 Terpinolene_O3 0.9153 

203 a-humulene_O3 0.8983 

333 Chamber m-Xylene peak growth SOA 0.8886 (Loza et al., 2012) 

321 Incense Coil 0.8859 (Li et al., 2012) 

185 Glycogen 0.8853 (Schneider et al., 2011) 

32 Utah Sage, Rabbitbrush 0.8841 (FLAME) 

2 

190 Casein 0.8280 (Schneider et al., 2011) 

336 Chamber m-xylene_high NOx 0.8087 (Chhabra et al., 2010) 

212 Myrcene_O3 0.7922 

(Bahreini et al., 2005) 

213 Terpinolene_O3 0.7916 

203 a-humulene_O3 0.7916 

220 Terpinolene_O3 0.7905 

204 a-terpinene_O3 0.7844 

218 a-Humulene_O3 0.7750 

32 Utah Sage, Rabbitbrush 0.7727 (FLAME) 

219 a-Terpinene_O3 0.7705 (Bahreini et al., 2005) 

3 

192 MethylAmmon_nitrate 0.8002 
(Murphy et al., 2007) 

191 Monoethan_nitrate 0.7944 

128 AmmoniumNitrate 0.7907 (Hogrefe et al., 2004) 

336 Chamber m-xylene_high NOx 0.7528 (Chhabra et al., 2010) 

238 photooxidized-Tma_O7 0.7507 

(Murphy et al., 2007) 195 Triethylamm_nitrate 0.7277 

193 TrimethylAmmon_nitrate 0.7200 

190 Casein 0.6770 (Schneider et al., 2011) 

334 Chamber m-Xylene aged SOA 0.6163 (Loza et al., 2012) 

333 Chamber m-Xylene peak growth SOA 0.6150  

4 

197 m-Xylene_O3 0.9587 

(Bahreini et al., 2005) 
213 Terpinolene_O3 0.9479 

220 Terpinolene_O3 0.9421 

212 Myrcene_O3 0.9410 

334 Chamber m-Xylene aged SOA 0.9387 (Loza et al., 2012) 

203 a-humulene_O3 0.9278 
(Bahreini et al., 2005) 

204 a-terpinene_O3 0.9191 

333 Chamber m-Xylene peak growth SOA 0.9063 (Loza et al., 2012) 

32 Utah Sage, Rabbitbrush 0.8960 (FLAME) 

321 Incense Coil 0.8947 (Li et al., 2012) 

5 

217 Bcaryophyllene_O3 0.9674 

(Bahreini et al., 2005) 
223 b-Pinene_O3 0.9489 

206 beta-pinene_O3 0.9406 

205 beta-caryophyllene_O3 0.9398 

https://www.zotero.org/google-docs/?6GcP8H
https://www.zotero.org/google-docs/?kzC6Ly
https://www.zotero.org/google-docs/?luYkon
https://www.zotero.org/google-docs/?mOx2Sm
https://www.zotero.org/google-docs/?xnoCDp
https://www.zotero.org/google-docs/?edfPJr
https://www.zotero.org/google-docs/?x4qsL3
https://www.zotero.org/google-docs/?Q7Z7As
https://www.zotero.org/google-docs/?ubkEPM
https://www.zotero.org/google-docs/?nWTGoO
https://www.zotero.org/google-docs/?u44Qcc
https://www.zotero.org/google-docs/?kpufHI
https://www.zotero.org/google-docs/?gpMDcw
https://www.zotero.org/google-docs/?3a9shu
https://www.zotero.org/google-docs/?MR6ek4
https://www.zotero.org/google-docs/?MdLb8k
https://www.zotero.org/google-docs/?DqwIw2
https://www.zotero.org/google-docs/?4b1apO
https://www.zotero.org/google-docs/?p7XPYa
https://www.zotero.org/google-docs/?cHqWt1
https://www.zotero.org/google-docs/?mtB7Ng
https://www.zotero.org/google-docs/?j8UDoX
https://www.zotero.org/google-docs/?kbliVQ
https://www.zotero.org/google-docs/?OLuuc8
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219 a-Terpinene_O3 0.9387 

218 a-Humulene_O3 0.9365 

222 Myrcene_O3 0.9186 

33 Lignin Powder 0.9171 (FLAME) 

234 Diesel_Exhaust_2 0.9167 
(Sage et al., 2007) 

235 Diesel_Exhaust_3 0.9160 

6 

217 Bcaryophyllene_O3 0.9545 

(Bahreini et al., 2005) 

223 b-Pinene_O3 0.9420 

206 beta-pinene_O3 0.9311 

205 beta-caryophyllene_O3 0.9281 

218 a-Humulene_O3 0.9236 

219 a-Terpinene_O3 0.9214 

33 Lignin Powder 0.9085 (FLAME) 

234 Diesel_Exhaust_2 0.9065 
(Sage et al., 2007) 

235 Diesel_Exhaust_3 0.9039 

31 Utah Juniper Foliage and Sticks 0.9004 (Sage et al., 2008) 

 

 

 

 

 

 

 

 

 

 

https://www.zotero.org/google-docs/?nmepRC
https://www.zotero.org/google-docs/?4xiHqZ
https://www.zotero.org/google-docs/?2nKEzF
https://www.zotero.org/google-docs/?bQ4vAH
https://www.zotero.org/google-docs/?lfreK0
https://www.zotero.org/google-docs/?jjhIFB
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<Figure S1. The screenshot of the UMR Database tab> 

 

 

<Figure S2: The screenshot of the HR Data Comparison tab> 
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<Figure S3. The screenshot of the HR Database tab> 

 

 

<Figure S4. The screenshot of the popped-up citation table when clicking the ‘Open metadata table’ 

Button on the panel, in either the HR Data Comparison tab> 
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Chapter 1. Getting started 

1.1 Files necessary for the AMS spectra database 

comparison panel 
In order to use the AMS spectral database in Igor Pro, users need two sets of files: i) the HDF 

(Hierarchical Data Format, or h5) database file and ii) two database procedure files (ipf) named ‘AMS 

MS database_v**.ipf’ and ‘AMS MS database_HR2UMR_v**.ipf’. Users can download the ipf files 

from the existing webpage (https://cires1.colorado.edu/jimenez-group/AMSsd/). Alternatively, users 

can download and open the Igor template experiment file (AMS_database_v**_template.pxt) for the 

AMS database, which already has the database and procedure files already loaded. The template file 

can be downloaded on the same webpage mentioned above. The panel and all other code described 

herein are compatible with Igor versions 7. 08, 8.04, and 9.02 for Macintosh and Microsoft operating 

systems. 

1.2 How to load the AMS spectral database and create the 

AMS spectral comparison panel in an Igor experiment 
The Igor Pro template experiment file (AMS_database_v**_template.pxt) already has the database and 

necessary procedure files loaded. However, when the user creates a new database h5 file or doesn’t 

have the template experiment file, the user can follow the processes below 

1) Open Igor pro program. 

2) On the top Igor menu, click [File] > [Open File] > [Procedure…] and open both procedure 

files: ‘AMS MS database_v**.ipf’ and ‘AMS MS database_HR2UMR_v**.ipf’ (Or drag both 

procedure files to the Igor Pro experiment). Compile the procedure files.  

3) On the menu, select [Data] > [Load waves] > [New HDF5 Browser]  

4) On the panel, select the ‘Open HDF5 file’ button and select the database h5 file that you want 

to import <Figure 1.1>  (Database h5 files must have ‘database’ and ‘databaseHR2UMR’ in 

the file name. Refer to ‘Chapter 5. Export the database’ to create a database h5 file). 

https://cires1.colorado.edu/jimenez-group/AMSsd/
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<Figure 1.1. HDF5 Browser panel when AMS database.h5 file has been opened.> 

5) On the ‘Groups’ section, select ‘database’ and click the ‘Load Group’ button and select 

‘databaseHR2UMR’ and click the ‘Load Group’ button again. <Figure 1.1> 

Caution: Both the ‘database’ and ‘databaseHR2UMR’ folders have to be uploaded in the ‘root:’ 

folder like below: 

  

<Figure 1.2. Required locations of ‘database’ and ‘databaseHR2UMR’ folders> 

 

6) Click the ‘Close HDF5 File’ button on the panel to close the HDF5 Browser panel. 
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7) On the top Igor menu, click [Database] > [Initialize] to create ‘databasePanel’ and ‘Globals’ 

folders in the ‘root:’ like <Figure 1.3> 

 

<Figure 1.3. Correct final folder locations to use the database panel> 

 

8) On the top Igor menu, select [Database] > [Database Panel] to open the database panel. 

9)  Database is now ready to use! 
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1.3 AMS/ACSM Database Export Tool 
For a more rigid standardization of data format, it is highly recommended to use AMS/ACSM 

database export tool within Igor experiments to create an HDF file that combines many spectra into 

one file with metadata fields. The created HDF file will be used on the ‘UMR Data Comparison’ and 

‘HR Data Comparison’ tabs of the panel as ‘New MS (refer to 2.1.1, 3.1.1)’. A new stand-alone ipf 

for this tool is being provided as a link on the existing website (https://cires1.colorado.edu/jimenez-

group/AMSsd/).   

Users should enter the metadata of their MS through the interface (Figure 1.4) and based on the 

entered metadata the HDF file will be named and created. Metadata categories on the export tool 

follow the ‘Comparison Constraints’ fields of the database panel (refer to 2.2.4). After the user has 

created an HDF file using the gold button in the panel, the HDF file generated from this tool will 

contain these entities (a wave in the Igor software is a matrix of numeric or text data): 

● 1D numeric wave called ‘mz’ 

● 1D text wave called ‘mzlabel’ 

● 1D text wave called ‘SpectraComments’ as metadata 

● 1D text wave called ‘SpectraName’ as metadata 

● 2D numeric matrix called ‘Spectra’ as MS 

● 2D text wave called ‘SpectraMetaData’ as metadata 

 

 

<Figure 1.4. Screenshot of AMS/ACSM Database Export Tool> 

https://cires1.colorado.edu/jimenez-group/AMSsd/
https://cires1.colorado.edu/jimenez-group/AMSsd/
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1.4 How to convert HR MS to UMR family grouped MS 
For UMR data, users don’t need additional pretreatment if one created the HDF file through the 

AMS/ACSM Database Export Tool. However, for HR data, the MS saved in the HDF file is in HR 

(with individual ion designations such as C2H3O) and  has no family designation stored in the HDF 

file using AMS/ACSM Database Export Tool. This section describes the steps for converting the HR 

data to UMR family grouped MS, if needed.  

1) On the menu, select [Data] > [Load waves] > [New HDF5 Browser] 

2) On the panel, select the ‘Open HDF5 file’ button and select the created HDF file that you 

created using the AMS/ACSM Data Export Tool. 

3) On the ‘Groups’ section, click the ‘Load Group’ button. 

 

※ Caution: The uploaded folder has to be placed in the ‘root:’ folder like below: 
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4) Click the ‘Close HDF5 File’ button on the panel to close the HDF5 Browser panel (If the HDF 

file is UMR data users can stop here). 

5) Within the Data Browser window, right-click on the created folder and select ‘Copy Full Path’ 

6) In the main Igor menu, select [Database] > [Convert HR2UMR] 

7) Enter the path of created folder like below: 

 

8) Press the Continue button. The code will generate converted UMR spectra with  HR family 

designation like below. 
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Chapter 2. Unit mass resolution (UMR) mass 

spectra comparison 

2.1 The selection of a mass spectrum of interest 

2.1.1 User supplied 1D/2D UMR MS 

 The user supplied 1D/2D UMR MS option is used to compare a user’s mass spectrum with mass 

spectra in the database. To use the user supplied 1D/2D UMR MS option, 3 waves are needed: i) MS 

spectra wave, ii) wave of m/z value matching the MS spectra, and iii) Species wave. Detailed 

information about the waves is described below (Figure 2.1): 

● MS wave: the 1D/2D wave of the mass spectrum from users. The wave values indicate the 

relative abundance of signal vs m/z in the mass spectrum. If the wave is in 2D,  each column 

should correspond to a mass spectrum. If one created an MS through AMS/ACSM 

Database Export Tool (1.3), this wave corresponds to the wave named ‘Spectra’.  

● m/z value wave: the 1D wave of m/z values matching the MS spectra wave. The m/z values 

should be integers.  The row number of this wave should match that of the MS spectra 

wave. If one created a UMR MS through AMS/ACSM Database Export Tool (1.3), this 

wave corresponds to the wave named ‘mz’. If one converted HR to UMR MS through the 

internal function in the AMS database, this wave corresponds to the wave named 

‘myHR2UMRmz’ 

● Species wave: the 1D text wave describing each mass spectrum. The row number of this 

wave should match the column number of the MS spectra wave. This wave corresponds to 

the wave named ‘SpectraName’ if one created the MS through AMS/ACSM Database 

Export Tool.  
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<Figure 2.1. An example of m/z value wave (‘mz’), MS wave (‘Spectra’), and Species wave 

(‘SpectraName’) wave in Igor> 

 

 To use the User supplied UMR MS option, users can follow the below: 

1) Check ‘User supplied 1D UMR MS’ to activate popup menus, if users have more than two 

mass spectra, check ‘User supplied 2D UMR MS’ 

2) Select a ‘Folder’ including the waves mentioned above. This folder has to be placed in the 

root folder. 

3) Select a MS Spectra wave (e.g. Spectra) from the ‘MS’ popup menu. 

4) Select an m/z value wave (e.g. mz) from the ‘mz’ popup menu. The list automatically 

shows only waves having the same number of rows as the MS wave. 

5) Select a species wave (e.g. SpectraName) from the ‘Species wave’ popup menu if you 

checked ‘User supplied 2D UMR MS’. 

5-2) If you checked ‘User supplied 2D UMR MS’, select a mass spectrum that one 

wants to compare with the database in the ‘MS wave’ popup menu. 

6) Click the ‘Compare’ button to calculate the cosine similarity of all MS in the database. 
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2.1.2 MS Existing in the data base 

  The existing MS option is used to compare a mass spectrum in the database with other reference 

mass spectra in the database. To use the Existing MS option, users can follow the steps below. 

1) Check ‘MS Existing in the data base’ to activate the ‘Sample Mass Spectrum’ list 

2) Click the mass spectrum to be compared in the list box. 

3) As soon as the user clicks the mass spectrum in the list box, cosine similarity is automatically 

calculated. 

2.2 A comparison result of the sample with reference mass 

spectrum and options 

2.2.1 UMR Comparison Result Table 

The result table consists of two columns: ‘Reference MS’ and ‘Score’. The ‘Reference MS’ column 

indicates the reference mass spectrum name in the list. The ‘Score’ column shows the calculated 

cosine similarity between the mass spectrum of interest and the reference mass spectrum in the 

database. The result is sorted by the score from largest to smallest. 

 

<Figure 2.2. Screenshot of result table on the ‘UMR Data Comparison’ tab> 
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2.2.2 UMR Comparison Result Mass Spectrum Plot 

The UMR data comparison tab provides 5 different types of plots: i) Sample MS, ii) Reference MS, 

iii) Sample and Reference MS, iv) Sample MS – Reference MS, and v) Sample MS vs Reference 

MS. Users can select the plot type through the pop menu. A detailed description of plot types is 

shown below: 

● Sample MS: mass spectrum of the selected mass spectrum to be compared in the selection 

region 

● Reference MS: mass spectrum of the reference mass spectrum selected in the result table. 

● Sample MS and Reference MS: mirror mass spectra of Sample MS (red) and Reference 

MS (black) 

● Sample MS – Reference MS: subtracted mass spectrum between Sample MS and Reference 

MS 

● Sample MS vs Reference MS: scatter plot between Sample MS (y-axis) and Reference MS 

(x-axis). It also provides regression information. 

The ‘Number of Tags’ option above the plot window is used to label the mass value on the mass 

spectrum from largest to smallest for as many as entered. For example, if 5 is entered, the top 5 mass 

value is labeled in the plot. Users can open the plot in a new window by pressing the ‘Pop’ button. 

 

<Figure 2.3. Screenshot of Plot window on the ‘UMR Data Comparison’ tab> 

2.2.3 Mass Spectra Rescaling Options 

Users can rescale the mass spectrum and its calculation by changing the mass range of the mass 

spectrum or increasing/decreasing m/z or intensity exponents. It rescales the mass spectrum based 

on equation 1 below.  

Weighted intensity = [m/z]m[Peak intensity]n (Eqn. 1) 
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As soon as the user changes the value in a variable box, the panel automatically calculates the 

cosine similarity with the reweighted mass spectrum and shows new results in the results table. 

 

<Figure 2.4. Screenshot of Scaling Options section on the ‘UMR Data Comparison’ tab> 

2.2.4 Comparison Constraints 

Users can use comparison constraints to filter the results in the database based on its metadata. It 

provides 6 categories to constrain the results: Database reference sample type, perturbation, 

deconvolution, instrument, MS resolution, and vaporizer type. The details of each category are 

described below. 

● Sample type: Origin of the aerosol. It indicates if there were any instrumental or experiment set-up 

conditions that are not reflective of general atmospheric conditions. Sample type is classified into 

‘Ambient’ (immediate ingestion of ambient air to the instrument) and ‘Non-ambient’ (including all 

chamber studies, any measurement whereby the spectrum is a specific source or a standard, or 

collected on filters as a preliminary step). 

● Perturbation: It indicates if there was a perturbation of the sample due to some instrumental 

intermediary. If the sampling was carried out with an oxidation flow reactor, thermodenuder, a 

sample collected on filters, etc, it is classified as ‘Perturbed’, if not, ‘Non-Perturbed’  

● Deconvoluted: It denotes if there was an analysis step such as positive matrix factorization (PMF). 

If yes, ‘Deconvoluted’, if not, ‘Non-deconvoluted’ 

● Instrument: It indicates the instrument used. It includes Air Quality ACSM, ToF-ACSM, Quad-

AMS, C-ToF-AMS, HR-ToF V-mode, HR-TOF W-mode, L-ToF V-mode, L-ToF W-mode, and 

multiple instruments. 

● Resolution: It shows the resolution of the sample spectrum. It includes unit mass resolution, high 

resolution, and combination (HR for low masses, UMR for high). Furthermore, if the spectrum is 

generated from HR to UMR, then the sample is assigned as HR that has been summed to UMR. 

● Vaporizer type: It includes a capture vaporizer and a standard vaporizer. 

● Aerosol CO and CO2 contributions: This indicates whether the signals of CO+ at m/z 28 and CO2
+ 

at m/z 44 in the mass spectrum were adjusted to be equal during the data processing. In the case of 

UMR data, the default signal from aerosol CO+ at m/z 28 is set to be identical to the contribution 

from aerosol CO2
+ signal at m/z 44 (Allan et al., 2004). Especially in the case of high biomass 

burning sources, users may have adjusted the organic component at m/z 28 to be different from that 

at CO2 at m/z 44. In the UMR case (‘mz 28/mz 44 = 1 (for UMR)’ on the UMR comparison tab of 

the panel), this option screens for cases when these two signals are equal, which is reflective of 

more ambient measurements and the default fragmentation table, and for cases when these signals 

are not equal (‘Ratio ≠ 1 (for both)’ on the UMR comparison tab), which is very uncommon. In the 

case of HR data, the default setting is to not fit the CO+ ion, as it is generally unseparated from the 

dominant N2
+ ion at m/z 28. The default setting in the HR fragmentation table is to set the signal of 

aerosol CO+ to aerosol CO2
+.  In terms of HR families, this default setting means that the family 

CHO1 signal at m/z 28 is equal to the family CHOgt1 signal at m/z 44. In the HR case (‘CO (CHO1) 

https://www.zotero.org/google-docs/?1Xb3ZK
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/ CO2 (CHOgt1) = 1 (for HRtoUMR)’ on the UMR comparison tab or ‘CO/CO2 =1’ on the HR 

comparison tab of the panel), this option screens for cases when these two signals are equal, which 

is reflective of more ambient measurements and the default HR fragmentation table, and for cases 

when these signals are not equal (‘CO/CO2 ≠ 1’ on the HR comparison tab of the panel), which is 

very uncommon.  

The user may select one or more desired constraint(s) and then press the ‘Apply’ button. At least 

one option must be selected in each category. 

 

<Figure 2.5. Screenshot of filtering option section on the ‘UMR Data Comparison’ tab> 

 

2.3 Citation information 
Citation information indicates the metadata of each mass spectrum. Users can obtain detailed 

information about the mass spectrum such as comments on each constraint category above, a short 

description of the selected mass spectrum, electron ionization (EI) energy, vaporizer temperature, 

experimenter’s name, provider’s group, citation URL, citation authors, and citation figure number.  

In order to see the citation information, users can press the ‘Open metadata table’ button and then 

a table pops up that includes the descriptions above. When a user clicks the ‘Open ’ button, it directly 

opens the paper on a web browser if the metadata has the citation URL. The top entry corresponds 

to the target mass spectrum and the bottom entry corresponds to the selected reference mass spectrum 

on the result table. If the target mass spectrum is ‘New MS’ from the user, the top ‘Get Citation’ 

button and ‘Open the paper’ buttons will be deactivated. 

 

<Figure 2.6. Screenshot of citation section on the panel> 
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Chapter 3. High resolution to unit mass 

resolution (HR) spectra comparison 

3.1 The selection of a mass spectrum of interest 

3.1.1 User supplied 1D/2D HR MS 

The User supplied 1D/2D HR MS option for HR data is used to compare a user’s mass spectrum 

with reference mass spectra in the database. To use the User supplied 1D/2D HR MS option for HR 

data, users need i) MS spectra wave, ii) wave of exact m/z value matching the MS spectra, iii) wave 

of m/z value label matching the m/z value wave, and iv) Species wave.  Detailed information about 

the waves is described below (Figure 3.1): 

● MS wave: the 1D/2D wave of the HR mass spectrum from users. The wave values indicate 

the relative abundance of signal vs m/z in the mass spectrum. If the wave is in 2D,  each 

column should correspond to a mass spectrum. If one created MS through AMS/ACSM 

Database Export Tool (1.3), this wave corresponds to the wave named ‘Spectra’. 

● m/z value wave: the 1D wave of m/z values matching the MS spectra wave. The m/z values 

should be an exact mass. The row number of this wave should match the MS wave. If one 

created an MS through AMS/ACSM Database Export Tool (1.3), this wave corresponds to 

the wave named ‘mz’. 

● m/z value label wave: the 1D string wave of m/z values label (chemical formula of HR 

fragments) matching the m/z value wave. If one created MS through AMS/ACSM Database 

Export Tool (1.3), this wave corresponds to the wave named ‘mzlabel’. 

● Species wave: the 1D string wave describing each mass spectrum. The row number of this 

wave should match with the column number of the MS wave. This wave corresponds to 

the wave named ‘SpectraName’ if one created the MS through AMS/ACSM Database 

Export Tool. 

 

 

<Figure 3.1 Examples of MS waves (‘Spectra’), m/z value wave (‘mz’), m/z value label wave (‘mzlabel’),  

Species wave (‘SpectraName’) for HR MS comparisons> 
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To use the User supplied 1D/2D HR MS option, users can follow the below: 

1) Check ‘User supplied 1D HR MS’ to activate popup menus, if you have more than two 

mass spectra, check ‘User supplied 2D HR MS’. 

2) Select a ‘Folder’ including the waves mentioned above. This folder has to be placed in 

the root folder. 

3) Select a MS wave (e.g. Spectra) from the ‘Spectra’ popup menu. 

4) Select an m/z value wave (e.g. mz) from the ‘mz’ popup menu. The list automatically 

shows only the wave having the same number of rows as the MS wave. 

5) Select an m/z value label wave (e.g. mzlabel from the ‘mz label’ popup menu. The list 

automatically shows only the wave having the same number of rows as the mz wave. 

6) Select a spectra name wave (e.g. SpectraName) from the ‘Spectra Name’ popup menu if 

you have more than two mass spectra. 

6-2) Select a mass spectrum that one wants to compare with the database in the ‘MS 

wave’ popup menu. 

7) Click the ‘Compare’ button to calculate the cosine similarity of all MS in the database. 

3.1.2 MS existing in the data base 

Please refer to 2.1.2. 

3.2 A comparison result of the sample with reference mass 

spectrum and options 

3.2.1 Result Table 

The result table for HR consists of three columns: ‘Reference MS’, ‘Score’, and ‘Score with HR 

family’. For the ‘Reference MS’ and the ‘Score’ column, please see 2.2.1. The ‘Score with HR 

family’ column represents the cosine similarity calculated only by the selected HR ion families.  
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<Figure 3.2. Example of a Result Table on ‘HR Data Comparison’ tab. ‘UMR score’ indicates 

cosine similarity calculated with UMR MS and ‘Score with HR family’ indicates cosine similarity 

calculated with summed and normalized MS of selected HR families > 

3.2.2 Mass spectrum plot 

The plot shows the stacked mass spectrum of the selected HR ion families such as Cx, CH, CHO1, 

CHOgt1, etc. Detailed information on HR ion families is described in 3.2.3. The top plot represents 

the target mass spectrum to be compared and the bottom does the selected reference mass spectrum 

in the database.  
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<Figure 3.3. Mass spectrum plot with the selected HR families on the ‘HR Data Comparison’ 

tab> 

3.2.3 HR family selection 

The HR ion families used here are the same names generated by PIKA which is the most commonly 

used AMS data analysis tool for HR. The panel also followed the same color legend from PIKA for 

consistency. The chemical formula for each HR ion family is described below. The ‘Other’ family 

indicates HR ions that are not a member of any other family. 

Table 3.1. The chemical formula of HR families 

HR family name Chemical formula 

Cx Cx 

CH CxHy 

CHO1 CxHyOz (z=1) 

CHOgt1 CxHyOz (z>1) 

CHN CxHyNw 

CHO1N CxHyOzNw (z=1) 

CHOgt1N CxHyOzNw (z>1) 

CS CxSy 

HO HxOy 

Air* Nx, Ox, Ar 

Cl HxCly 

NH NxHy 

SO SxOy 

NO NxOy 

Tungsten* WxOy (y ≥ 0) 

Other - 

CSi CxSiy 

*On HR data comparison tab, the abundances of air and tungsten is reset to zero. 
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3.2.4 Mass Spectra Rescaling Options 

Please see 2.2.3. 

3.3.5 Comparison Constraints 

For an HR spectra comparison, the panel provides the same categories as the UMR data comparison 

tab except for the ‘Instrument’ and ‘MS resolution’ options. In the case of HR spectra, several non-

applicable options are removed. Please refer to 2.2.4 for a detailed description.  

3.4 Citation information 
Please see 2.3.  
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Chapter 4. Database library 
On the UMR Database and HR Database tabs, the panel plots the reference mass spectrum in the 

database and provides its metadata for users to look through easily. The list box presents the name 

of the reference mass spectrum in the database. When the user clicks one of them, the corresponding 

mass spectrum or stacked mass spectrum (HR) and metadata are displayed. The example displays for 

a UMR and an HR reference spectrum are below. 

 

<Figure 4.1 The UMR Database tab> 
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<Figure 4.2 The HR Database tab>  
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Chapter 5. Export database 
 To export a database from Igor Pro to an h5 file, users have to save all the waves and strings in the 

‘database’ and ‘databaseHR2UMR’ folders. The following steps describe how to export a database to an 

h5 file: 

1) On the menu, select [Data] > [Load Waves] > [New HDF5 Browser]. 

2) On the HDF5 browser panel, click the ‘Create HDF5 File’ button. 

3) Enter the name of the HDF5 file.h5 to be created. Users must include ‘.h5’ at the end of the file 

name. 

4) On the panel, click the  ‘Save Data Folder’ button. 

5) On the ‘Save Data Folder as HDF5 Group’ panel, select both the ‘database’ and 

‘databaseHR2UMR’ folders. 

 

<Figure 5.1 The Igor window prompting the user to select data folders > 

6) Check the ‘Save Groups Recursive’ and ‘Include Igor Attributes’ and click the ‘Save’ button. 
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7) Confirm that both folders are loaded in the ‘Groups’ window (on the left below) and check that 

everything is there on the right by clicking ‘database’ and then ‘databaseHR2UMR”. 

 

<Figure 5.2 A section of the Igor window in the HDF5 Browser panel> 

 

8) Click the ‘done’ button on the ‘Save Data Folder as HDF5 Group’. 

9) Click the ‘Close HDF5 File’ button on the panel to complete the creation of the database library 

file. 

 

 


